
Slide 1 soterweb.org.uk
Copyright © 2022

Permit to Work Module – Client Prospective
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PROCEDURE PURPOSE

This procedure will guide you through the Permit Module on SOTERweb, this includes Client representative raising a

Permit, a Contractor requesting a Permit for planned work and Operatives requesting a permit via the Access IT

module.

PREREQUISITES

1. Client representatives should have a profile of either an Administrator or Power User.

2. Contractors should have a profile of Admin (External Contractor) or Admin (External Consultant) to provide

management acceptance of the Client key expectations and provide the necessary RAMS or to request a permit

on behalf of the organisation.

3. Operatives need to be designated as a User (External) and have the particular permit assigned to them to them,

their organisation or profile in order to activate an approved Permit on-site and to request a reactive permit whilst

on site.

HELP SUPPORT

Name Role Email Telephone Mobile

Rik Hutchins System Developer Rik@montgomeryandcoupers.co.uk 0845 163 0134 0790 303 9694
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Module Overview
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✓ Built in Permits with configurable question banks & guidance.

✓ E-permits, hardcopy or a mix.

✓ User definable permissions.

✓ Raise, request, accept, reject, extend &  suspend permits with ease.

✓ Upload RAMS, training records & certificates. 

✓ Provides live RAG permit status.

✓ Uses email automation with inbuilt active links.

✓ Incorporates a 3rd party verification process.

✓ Automated clash / conflict checker.

✓ Mobile friendly, fully auditable.

✓ Real time dashboard exception reporting.

Module Overview 
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Client initiated Permits for Planned Work*

1 2 3 4 5 6 7

Who Client Contractor Client Client
Contractor

or Operative

Contractor

or Operative
Client

Process
Raises Permit 

to Contractor

Agrees date, 

confirms key 

expectations & 

uploads RAMS

Reviews 

answers 

provided & 

RAMS

Approves work 

to commence

Completes pre-

start questions 

& starts the 

work

Extends, 

suspends, or 

finishes work. 

Answers post-

work questions 

& uploads 

image 
(if desired)

Closes Permit

Supporting 

Icon

Status New Confirmed Confirmed Approved Started
Suspended or 

Finished
Closed

Communicated Automated Email Automated Email Automated Email Automated Email Automated Email Automated Email N/A

* System Default
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Client initiated Permits for Reactive Work

1 2 3 4 5 6 7

Who Client Contractor Client Client
Contractor

or Operative

Contractor

or Operative
Client

Process
Raises Permit 

to Contractor

Agrees date, 

confirms key 

expectations

Reviews 

answers 

provided

Approves work 

to commence

Completes pre-

start questions 

& starts the 

work.

Extends, 

suspends, or 

finishes work. 

Answers post-

work questions 

& uploads 

image
(if desired)

Closes Permit

Supporting 

Icon

Status New Confirmed Confirmed Approved Started
Suspended or 

Finished
Closed

Communicated Automated Email Automated Email Automated Email Automated Email Automated Email Automated Email N/A

Notes:

• The number of inbuilt questions are fewer to support the use of mobile devices.

• There is no requirement to upload RAMS. 
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Contractor initiated Permits for Planned Work*

1 2 3 4 5 6 7 8

Who Contractor Client Contractor Client Client
Contractor

or Operative

Contractor

or Operative
Client

Process

Raises a 

permit 

request

Review 

request & 

approves 

request

Confirms key 

expectations 

& uploads 

RAMS

Reviews 

answers 

provided & 

RAMS

Approves 

work to 

commence

Completes 

pre-start 

questions & 

starts work

Extends, 

suspends, or 

finishes 

work. 

Answers 

post-work 

questions & 

uploads 

image 
(if desired)

Closes 

Permit

Supporting Icon

Status Request New Confirmed Confirmed Approved Started
Suspended or 

Finished
Closed

Communicated Via
Automated 

Email

Automated 

Email

Automated 

Email

Automated 

Email

Automated 

Email

Automated 

Email

Automated 

Email
N/A

* System Default
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Contractor initiated Permits for Reactive Work

1 2 3 4 5 6 7 8

Who
Contractor

Client Contractor Client Client
Contractor or 

Operative

Contractor

or Operative
Client

Process

Raises a 

permit 

request

Reviews 

request & 

confirms 

request is ok

Confirms key 

expectations

Reviews 

answers 

provided

Approves 

work to 

commence

Completes 

pre-start 

questions & 

starts work

Extends, 

suspends, or 

finishes work. 

Answers post-

work 

questions & 

uploads image 
(if desired)

Closes Permit

Supporting 

Icon

Status Request New Confirmed Confirmed Approved Started
Suspended or 

Finished
Closed

Communicated Automated Email Automated Email
Automated 

Email
Automated Email Automated Email Automated Email Automated Email N/A

Notes:

• The number of inbuilt questions are fewer to support the use of mobile devices.

• There is no requirement to upload RAMS. 
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Operative initiated reactive Permits via Access IT

1 2 3 4 5 6

Who Operative Operative Client Operative Operative Client

Process

Operative raises permit 

request via Access IT 

Module

Operative complete 

key expectations

Client reviews 

answers to key 

expectations and 

Approves work

Operative on site, 

completes pre-start 

questions & starts 

work
(system checks for potential 

conflicts)

Operative extends, 

suspends, or finishes 

work. Answers post-

work questions & 

uploads image
(if desired)

Client Closes 

Permit

Supporting Icon

Permit Status Request Confirmed Approved Started Suspended or Finished Closed

Communicated Automated Email Automated Email Automated Email Automated Email

Note:

On-site reactive permits are designed to deal an operative already on site realises a permit is needed. They do not 

incorporate the facility to upload RAMS and the number of inbuilt questions is limited to facilitate the use of mobile 

devices. The Client should use their judgement whether to approve the permit request or not. 
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How system identifies the appropriate Client Contact for Permit Requests

Note

Data protection prevents the contractor being able to select a named Client representative. Therefore the system

selects the appropriate Client contact using the following workflow.

The FM Manager (Permits) within Estates – Location - Location Contact tab and the Managed by function. 

The ‘FM Manager (Permits) within Estates – Location - Location Site tab and the Managed by function. 

1ST person aligned ‘Permit Organisation Manager’ within permissions.

Individual linked to the Permit Type within the Client Organisation Module.

Individual linked to the Permit Type within the Contractor Organisation Module.

Individual linked to the Managed By function within the Contractor Organisation Module.

The contact ID under ‘Permit Planned Organisation within System Parameters.

1st 

select

3rd 

select

4th 

select

5th 

select

6th 

select

2nd

select

7th 

select
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Standard Permissions
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Standard Permissions 

Clients

• Can raise, approve, suspend, extend and close permits and ask for 3rd party verification of a set

of RAMS associated with a particular permit.

Contractors (with an admin profile)

• Can request a permit, complete and submit acknowledgement of key expectations. Upload

RAMS and other supporting documents. They can also activate, request an extension or

complete and suspend a Permit.

Operatives

• Can activate an approved permit. Request a reactive permit, extend, suspend and complete an

existing Permit via the Access IT module.
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Locating the Permit Module
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From your Home Screen

Click the PROJECTS tab1
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Click Permits

To find Permit Module

2
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Select the Permit

To find Permit Module

3
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Permit Home Screen

This is the Permit home screen. It presents an overview 

of all active permits. If you are a contractor this will be

restricted to those aligned to your organisation.
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Explanation of the primary 

icons used in the Permit 

Module
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Arrive at the main Permit screen

…lets look at these icons and explain what they do…
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Icons What They Do

Approve Request 
Aimed at the Client contact this is where you Approve a Contractor initiated Permit Request to 

start the standard Permit workflow. 

View/Edit Dependant upon Permissions you can View and Edit Permit details via this icon 

Confirm 

Expectations
Aimed exclusively at the contractor this is where they acknowledge the ‘Key Permit 

Expectations. 

Upload Supporting 

Documents
Aimed exclusively at the contractor this is where they upload their RAMS and other supporting 

documentation.

Verify 

Expectations
Aimed exclusively at the Client contact this is where you can review, reject & reject but ask the 

contractor to resubmit the answers provided to the Key Permit Expectations.

Verify RAMS
Similar to the above, aimed at the Client contact allowing you to review, reject & reject but ask 

the contractor to resubmit RAMS.

3rd Party 

Verification
This allows Client contacts to ask a 3rd Party to review, reject & reject but ask the contractor to 

resubmit a set of RAMS.

Approve
When contractor has uploaded their RAMS & other documentation this will become visible.  You 

can then review documents provided.

Permit Home Screen – Icons 
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Icons What They Do

Start Work
Click to let the system know the work has started.  This will initiate the prestart questions and 

conflict checker.  This function can also be initiated via the Access IT module. 

Suspend Work
Temporarily suspend work if needed.  This function can be initiated by the Client, Contractor or 

the Operative on site.

Request to Extend
Need an extension to a Permit then request an extension through this icon.  Requests are sent 

to the Permit Manager and whether it is approved or reject communicated via email automation.

Upload Picture Provides the facility for the Contractor or Operative on site to upload a picture if desired.

Finish Work
Click to let the system know the work has finished.  This will initiate some closing questions. This 

function can also be initiated via the Access IT module. 

Close Permit Allows the Client contact to close the permit once all keys and equipment have been returned.

Keys & Equipment 

Register
Allows the Client contact to log keys or other equipment issued to the contractor against the 

permit.

Send Email
This allows either the Client or the Contractor to send the an email to a 3rd Party incorporating a 

link to the permit.

Preview Permit Print, download the Permit via this icon.

Permit Home Screen – Icons 
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Adding a new a Permit
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To raise a New Permit

From the permit home screen press the Add Permit icon1
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Complete the new permit screen

Main Permit input Screen

Note:

1. Select permit type from drop down list.

2. Assign the Permit to a receiving organisation and an individual (the individual must have a admin profile). 

3. Complete the desired start and finish date and time.

4. Press Save.  The system will save the Permit details and add it to the Permit Home screen. 

2

1

3

4

2
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Email Automation

An email automation will be sent to 

the Contractor informing them of the 

Permit and action to take. 

Note: 

The status will change to New and the Confirm 

Expectations and Upload Supporting Documents

icons become live.
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Expectations & RAMS

The contractor needs to

acknowledge the minimum health & 

safety expectations via the Confirm 

Expectations icon and upload their 

RAMS via the Supporting 

Documentation icon.

3
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Uploading RAMS

To upload RAMS click the Upload Document icon4
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Contractor uploads RAMS

Read and Accept the declaration5
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Contractor uploads RAMS

Add a document by clicking Browse. Then locate the 

document and double click to add the document to the system. 

Then press save.

6
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Contractor uploads RAMS

To change the document you’ve selected click Upload Document again.  You 

will be able to view the original document but the system will require another 

document or the same document to be uploaded.

To add multiple documents click the Add Document icon, and add additional 

document/s. (see next slide)

When ready, proceed by clicking the Confirm / Proceed icon.

1

2

3
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Adding multiple document

Note:

You will not be able to save an additional document unless a brief 

description in the Document Type field is provided before it is 

uploaded. Failure to do this will mean you will need to re-upload the 

document before pressing save.
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Automated Email

The Client contact will be notified when 

the contractor has acknowledged the 

expectations and uploaded their 

RAMS.
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Client - Review Responses 

From the Permits Home screen

the Verify Expectations & Verify RAMS

icons become active.

Note:

The permit status will change to Confirmed.  

7
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Client – reviews responses

Client contact reviews responses and can 

Return Permit - for further consideration.

Reject Permit - which will close the Permit.

Approve Permit 

1

2

3
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The Client contact can also seek 

3rd Party Verification of the submitted RAMS (if desired) by 

clicking the 3rd Party Verification icon.

3rd Part Verification

8
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3rd Part Verification

Then add an email address and click save and

the system will send an email automation with an 

embedded link to allowing the RAMS to be 

reviewed by a 3rd Party.
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The 3rd Part Verification Screen

The 3rd Party can 

Download / View the RAMS

Provide comments

Approve or Reject the RAMS.

1

3

2
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Approve work

When comfortable the Client contact can approve the 

Permit by clicking on the Work Approved icon.  

The Contractor will be alerted of this via email automation.

9
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Contractor receives a notification 

Note: 

Status will change to Approved and the Start Work 

icon will become active.
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Activating a Permit via Access IT
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Via main home screen click the ACCESS IT tab

Operative activates a Permit.

1
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Click Login

To activate a Permit

2
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Logs in the Access IT 

Complete Username and Password fields.

Click Carry out work under an Existing Permit.

Click Proceed.

1

3

2
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Select the Approved Permit

Operative will arrive at the Permit screen which shows all 

approved Permits for the organisation.  

To activate a Permit click here.
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Complete pre-start questions

Note:

Answer the Pre-start Questions.

Dependant upon the Permit type, a Secondary contact may be required.

Press the Confirm Questions  icon.

1

2

3
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Client – Receives an Email

The Client contact is notified the 

operative has started work via email 

automation.

Note: Status has changed to Started.
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Closing a Permit via Access IT
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To Close a Permit via Access IT

Within the Access IT Log Out Screen 

Complete the Username and Password fields.

Click Log Out of Site and Close Permit.

Click Proceed.3

2

1



Slide 50 soterweb.org.uk
Copyright © 2022

Select Permit to Close

Indicate which Permit you wish to close by 

clicking here.
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Answer closing questions

Answers the Closing Questions.

Press the Confirm icon.  

Note

A system generated email will notify the Client 

representative that work has finished.

1

2
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Request a Permit via the main system
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Requesting a Permit

Dependant upon permissions 

Contractors can Request a Permit 

through the system for both Planned 

and Reactive Work.
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Requesting a Permit

From the Permit Home screen, the Contractor presses 

the Request a Permit icon
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Contractor completes the screen by filling in the fields.

Contractor Completes Request Screen

Note:

1. Select permit type from drop down list.

2. Assign the Permit to a receiving organisation and an individual (the individual must have a admin profile). 

3. Complete the desired start and finish date and time.

4. Press Save.  The system will save the Permit details and add it to the Permit Home screen. 
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Client Contact is notified of the request

An email automation will be to the 

appropriate Client contact notifying 

them of the Permit request.

Note: 

The status changes to Request.



Slide 57 soterweb.org.uk
Copyright © 2022

Client Contact reviews the request 

The Client Contact reviews the request and click the Confirm Permit 

Request icon if happy for the request to proceed.
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Main Permit Screen is updated

The Permit Request is also added to the main Permit screen
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Email Automation

Once approved an email automation 

will notify the requester of the 

outcome.  

Note: 

If approved the status will change to New

The Confirm Expectations and Upload Supporting 

Documents icons become live.
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Request a Permit via Access IT.
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Overview of the Process

STEP 1 STEP 2 STEP 3 STEP 4 STEP 5 STEP 6 STEP 7 STEP 8

Who Operative Operative Client Client Operative Operative Operative Client

Process

Whilst on 

site an 

Operative 

raises a 

Permit 

Request 

via Access 

IT module.

Operative 

confirms key 

expectations

Client 

Contact  

reviews 

Permit 

Request

Client 

reviews 

answers 

provided by 

Operative 

and 

approves 

Permit

Operative 

returns to 

Access IT 

module to 

activate 

Permit

Operative 

completes 

pre-start 

question & 

starts work

Finishes 

work & 

answers 

post-work 

questions 

& uploads 

image
(if desired)

Client 

Close 

Permit



Slide 62 soterweb.org.uk
Copyright © 2022

Logs in the Access IT 

Complete Username and Password fields.

Click Carry out work under an Existing Permit.

Click Proceed.

1

3

2
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Request a Permit Facility via Access IT 

Complete Username and Password fields.

Click Request a New Permit.

Click Proceed.

1

3

2
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Complete the Request Screen
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Administration
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QUICK PERMITS (Configuration)

1. Create a New Permit Type Control Panel > Edit List > Permit Types > Add

a) Complete the Details and enter QUICKPERMIT in the Permit Parameters box. 

2. Create the Manager for the Permit Organisation > Edit > My Organisation > Managed By       > Add

a) Select the contact Name who manages the Permit

b) Select the contact Type (This is the Name of the Permit)

3. Add the Permit to the contacts who can Request the Permit Project > Permits >                                                         > Edit 

4. Send the contact a Email Link to add the Permit(s) when required. Project > Permits >                                > Activate

5. Associated Email Automation

a) Permit Request (contact URL Authentication Link)

b) Permit Requested (QUICKPERMIT) Send to Client contact

c) Permit Approved 

d) Work Started 

e) Work In Progress (Standard System Emails)

f) Permit Work Finished

g) Permit Closed

6. Add Profile Permissions for the Permit - Request Edit Screen – Button – Save 
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END OF DOCUMENT


